
  

 



  

 
 
 
 
 
 

WARRANTY 
 
Hamar Laser Instruments, Inc. warrants each instrument and other articles of 
equipment manufactured by it to be free from defects in materials and 
workmanship under normal use and service.  Its obligation under this warranty 
are limited to making good at its factory any instrument and other article of 
equipment, which shall, within one year after shipment of each instrument and 
other article of equipment to the original purchaser, be returned intact to Hamar 
with transportation prepaid, and which Hamar’s examination shall disclose to 
Hamar’s satisfaction to have been thus defective. Other than this express 
warranty, Hamar neither assumes, nor authorizes any other persons to assume for 
it, any other liability or obligation in connection with the sale of its products. 
 
This warranty is not applicable to instruments or other articles of equipment 
manufactured by other companies and limited by a warranty extending for less 
than one year. In such an event, the more limited warranty applies to said 
instrument or article of equipment. 
 
This warranty shall not apply to any instrument or other article of equipment 
which shall have been repaired or altered outside the Hamar factory, nor which 
has been subject to misuse, negligence, or use not in accord with instructions 
furnished by the manufacturer. 
 
The software described in this manual is furnished under a license agreement and 
may be used or copied only in accordance with the terms of the agreement.  It is 
against the law to copy the software on any medium for any purpose other than 
the purchaser's personal use. 
 
The information in this manual is subject to change without notice. No part of 
this manual may be reproduced by any means, electronic or mechanical, without 
written permission from Hamar Laser Instruments, Inc. 
 

©  Copyright Hamar Laser Instruments, Incorporated, 2020 
5 Ye Olde Road, Danbury, Connecticut 06810 

 



  

Table of Contents 
 
 
Bore9 Alignment Software for the R-1307 Readout ..................................................................................................... 1 

Compensating for Mounting Errors ........................................................................................................................... 1 
Bore9 Features........................................................................................................................................................... 1 
Preparing for an Alignment ....................................................................................................................................... 2 

Hardware Preparation ...................................................................................................................................... 2 
Connecting to a Computer Interface .......................................................................................................................... 2 

Connecting to the R-358 Computer Interface .................................................................................................. 3 
Pulse/Continuous Modes (L-705 and L-706 Lasers) ....................................................................................... 3 

The Model R-1307 Readout ...................................................................................................................................... 4 
Configuring the R-1307C, R-1307-900/2.4 or R-1307-2.4ZB for a Cabled (Local) Target ........................... 4 

Hardware Configurations............................................................................................................................................... 7 
Pre-installing the Common USB Port Driver (A-910-2.4ZB) ................................................................................... 7 

Installing the Driver ........................................................................................................................................ 7 
Configuring the Hardware and Utility Settings ......................................................................................................... 8 
Installing the Bore9 Alignment Software .................................................................................................................. 9 

System Requirements ...................................................................................................................................... 9 
Installing Microsoft .NET Framework 4 ....................................................................................................... 10 
Installing Microsoft Access Database Engine ............................................................................................... 11 
Installing Bore9 ............................................................................................................................................. 12 

What is Bore Plot? ....................................................................................................................................................... 13 
Continuous vs. Individual Bores ............................................................................................................................. 13 
Error Correction: The NORMIN Procedure ............................................................................................................ 13 
Measuring Alignment and Size ............................................................................................................................... 13 

Hardware Setup ............................................................................................................................................. 14 
Bucking In ..................................................................................................................................................... 14 
Bore Setup ..................................................................................................................................................... 14 
Recording Data .............................................................................................................................................. 14 
Plotting Results ............................................................................................................................................. 14 
Saving, Printing, and Reviewing Results ...................................................................................................... 14 

Getting Started with Bore9 .......................................................................................................................................... 15 
Hamar Product Registration .................................................................................................................................... 15 
Creating a New Project File or Opening an Existing Project File ........................................................................... 16 
Standard Features of the Bore9 Screens .................................................................................................................. 17 

The Menu Bar................................................................................................................................................ 18 
The File Menu ............................................................................................................................................... 18 
The Navigate Menu ....................................................................................................................................... 18 
The Help Menu.............................................................................................................................................. 18 
Navigating in Bore9 with the Status Bar ....................................................................................................... 19 

Target Setup ............................................................................................................................................................ 20 
Calibration Constants .................................................................................................................................... 21 

Setting R-1307 Target Network ID to Match the Settings in Bore9 Target Setup .................................................. 23 
Setting System ID (Radio Channel) for the R-1307 ...................................................................................... 23 

Preferences .............................................................................................................................................................. 24 
Decimal Display ............................................................................................................................................ 24 
Company Information ................................................................................................................................... 24 
Data Grid Display .......................................................................................................................................... 24 
Units .............................................................................................................................................................. 25 
Record Mode ................................................................................................................................................. 25 

  



  

Setting up a Bore Alignment Project ........................................................................................................................... 26 
Step 1 - Setup .......................................................................................................................................................... 26 

Select Target to Use ...................................................................................................................................... 26 
Number of Targets ........................................................................................................................................ 26 
Interpreting Target Data Signs (+, -) ............................................................................................................. 27 
Number of Bores ........................................................................................................................................... 27 
Bore Spacing ................................................................................................................................................. 27 
Reference Bore Diameters ............................................................................................................................. 28 
Laser Position ................................................................................................................................................ 28 
Tolerance Bands ............................................................................................................................................ 28 
Bore-to-Bore.................................................................................................................................................. 28 
Graphing ........................................................................................................................................................ 29 

Step 2 – Target Mounting Error .............................................................................................................................. 30 
Step 3 – Buckin (Laser Setup) ................................................................................................................................. 31 

Laser Mounting Options ................................................................................................................................ 31 
Step 4 – Record Data – Single Target ..................................................................................................................... 41 

Auto Step ....................................................................................................................................................... 41 
Direction ........................................................................................................................................................ 41 
Taking Data in Step 4 (Single Target – typical use) ...................................................................................... 42 

Step 4 – Recording Alignment Data and Bore-Diameter Changes.......................................................................... 44 
Step 5 – Results and Analysis ...................................................................................................................................... 46 

Plot Reference ......................................................................................................................................................... 46 
Show Features ............................................................................................................................................... 48 
Other Features of the Bore Plot Screen ......................................................................................................... 49 

Generating a Report ................................................................................................................................................ 50 
Exporting Alignment Data to Excel Spreadsheets......................................................................................... 52 

Appendix A - The NORMIN Procedure ...................................................................................................................... 54 
Appendix B – The A-910 Radio Transceiver/Hub ...................................................................................................... 56 

Front Panel Features ...................................................................................................................................... 56 
Rear Panel Features ....................................................................................................................................... 56 

Using the R-1307 with a Local Target and the A-910 Radio Transceiver .............................................................. 57 
Setting the Target Network ID and System ID for the R-1307 Readout ....................................................... 57 
Miscellaneous Display Messages .................................................................................................................. 57 

Appendix C - Agency Certifications ........................................................................................................................... 58 
Appendix D – The R-1307 Menu ................................................................................................................................ 59 
Appendix E – Manually Selecting the COM Port ....................................................................................................... 60 

Setting the Target System ID and Target Network ID ............................................................................................ 60 
Setting the System ID .................................................................................................................................... 60 

Setting the Target Network ID and System ID for the R-1307 Readout ................................................................. 61 
Miscellaneous Display Messages .................................................................................................................. 61 

Appendix F – Converting X-Y Coordinates to Polar Coordinates in Alignment Reports ........................................... 62 
Appendix G – Entering Data Manually in Bore9 ........................................................................................................ 63 
Appendix H – Laser Buckin for Gearbox AOR (Manual Method) ............................................................................. 70 

Laser Buckin AOR Procedure ................................................................................................................................. 70 
Appendix I – Laser Buckin for Gearbox AOR (Rough Buckin Visual Method) ......................................................... 72 

Rough Laser Buckin Using the Visual Method ....................................................................................................... 72 



 

 1  

Bore9 Alignment Software for the R-1307 Readout 
 
Bore9 Alignment Software measures and displays the alignment of multiple bores. It measures bore 
straightness (axis centering) and size (diameter) using one of the bores as a reference. Applications 
include turbines, engine blocks, rotary compressors, extruder barrels, gun barrels, hydraulic cylinders and 
printing press bearings. 
 
Compensating for Mounting Errors 
 
Target and laser mounting errors must be compensated for in order to achieve accurate results in bore and 
spindle work. Bore9 uses the NORMIN method developed by Hamar Laser. The NORMIN method is a 
quick and precise way of canceling out these errors and eliminates the need for complicated, expensive 
fixtures. The word NORMIN is a contraction of NORMal-INverted, which briefly describes the method. 
 
One unit (target or laser) is set in the NORMal (cable down) position, and the other rotated 180 degrees to 
the INverted (cable up) position. A set of INverted readings is taken. Then the laser and target are both set 
in the NORMal (cable down) position and the readings are recorded. In some cases, three readings are 
taken: target NORMal and laser INverted, laser NORMal and target INverted, and both units NORMal.  
The readings are then averaged to cancel out both centering and angular mounting errors and provide a 
very accurate result. A detailed description of the NORMIN procedure can be found in Appendix A, 
beginning on Page 54.   
 
Bore9 Features 

 
• Live display 

The plot displays move with each adjustment, allowing the user to see the misalignment and 
correct it easily.  

 
• Offsets 

Bore9 allows the user to develop or enter various offsets or error corrections. The offsets can be 
toggled on and off as required and include the following capabilities: 
 Zero 
 Buckin 
 Manual Offset 
 Align Target  

• Save, print and analyze recorded data 
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Preparing for an Alignment 
 
There are several preparations that need to be made before beginning a measurement or alignment proc-
ess. Ensure that accurate records are kept for all procedures.  
 
Hardware Preparation 
 
• Determine what hardware is necessary to perform the alignment, including the laser, target, mounting 

fixtures, readouts or interface, cables, etc. Make a note of the target model number so that the infor-
mation can be entered into the program setup. 

 
• If a test or measurement is expected to take more than 3-4 hours, be sure to connect portable 

computers, interfaces, and other battery-operated devices to their external power supplies.  
• Observe safety precautions when setting up hardware.  Lock out machines for stationary procedures.  

If a machine is running, set up barriers and/or warning signs and route all cables away from moving 
parts. Clean and check all equipment, fixtures, and mounting surfaces before beginning any alignment 
process. 

 
Connecting to a Computer Interface 
 
Hamar Laser’s computer interfaces couple with a portable 
computer to act as a readout and allow the use of the Bore9 
program to perform calculations, display live laser beam-to-
target position information, and plot results.   

 
• The R-358 Interface attaches to the computer with an RS-

232 cable and is powered by a lithium ion battery or an AC 
adapter. The R-358 is available in both standard (.0001 in.) 
and high-resolution (.00001 in.) versions.  

• The wireless A-910 Interface for Hamar Laser’s Type II 
Universal Wireless Targets incorporates a built in radio 
transceiver available in 900 MHz or 2.4 GHz. Operating 
through the A-910 Radio Transceiver/Hub, up to 99 Type II 
Targets may be connected as a Target System Group, and up 
to ten Target System Groups consisting of 99 targets per 
group may be used at one time. The 900MHz model has an 
indoor range of 300 feet (91 meters) and the 2.4 GHz model has an indoor range of 600 ft. (1.83 m). 
Data transmission is 4 mW and 50 mW respectively. See Appendix B on Page 56 for configuration 
instructions.   

 
Warning: You must install the A-910 Driver before inserting it into the USB port!!! 
 

• The A-910-2.4ZB Interface is used for up to 99 targets. The A-910ZB is a very small, USB-powered 
2.4GHz radio transceiver that can read up to four targets simultaneously. If you are using the A-910-
2.4ZN Interface, see Appendix E on Page 60 for configuration instructions.  

 
 

 
 

Figure 1 – A-910-2.4ZB Interface 



 

 3  

Connecting to the R-358 Computer Interface 
 
Note: Before using the R-358 Computer Interface, ensure that the battery is fully charged or that the AC 
charger/adapter is plugged in. Make all connections with computer powered off. 
 
1. Connect the target(s) to the INPUT connector on the front of the R-358 Interface.  

The interface can support one 4-axis target. It can also support two 2-axis targets with the use of 
an optional splitter cable.  

 
 

Figure 2 – R-358 Computer Interface Connections 
 
2. Connect the R-358 Interface to the computer.  

Connect the interface to the computer serial port using the standard RS-232 cable provided. The 
connector for the cable is located on the back of the unit and is labeled COMPUTER. 

3. Turn on the computer. 
 
Pulse/Continuous Modes (L-705 and L-706 Lasers) 
 
The L-705 and L-706 Lasers are now equipped with a PULSE/CONTinuous switch, which manually 
switches the laser beam between Pulsed and Fixed Beam Modes. Pulse Mode automatically removes the 
effects of excess (ambient) background light for the R-1307 readouts, providing a more accurate reading. 
The R-1307 Readout is capable of supporting both Pulse Mode and Continuous Mode as well as storing 
up to nine different target calibration factors for multiple target users. These capabilities must be specified 
when ordering a system. 
 
The chart below indicates the operational modes for Readouts/Computer Interfaces that operate with the 
L-705/L-706 Lasers: 
 

Mode Readouts Computer Interfaces 
Pulse R-1307B-2.4ZB, R-1307BC, R-1307C, R-

1307-900/2.4, R-1307-2.4ZB, R-1307+R 
A-910-900/2.4  

(when used with R-1307-900 or R-1307-2.4) 
A-910-2.4ZB 

CONTinuous R-307, R-307V R-358 
  
Notes:  
1. The T-261A and T-266 Targets do not support the Pulsed-Beam Mode and the system purchased is factory-

configured to operate in CONTinuous mode when using these targets.  
2. When using the L-700 Laser with the R-1307 and a 2-Axis Target, the system is factory-configured to operate in 

CONTinuous mode.  



 

 4  

The Model R-1307 Readout 
 
The Model R-1307 Readout supports both wireless Unitargets, such as the 
A-1519, or local (cabled) targets. It is available with a radio frequency of 
either 900 MHz or 2.4 GHz ISM band. The R-1307 can be used as the 
primary readout or as an additional readout to copy position data captured 
by another R-1307.    

 
Configuring the R-1307C, R-1307-900/2.4 or R-1307-2.4ZB for a 
Cabled (Local) Target 
 
Note: Shut off power to the readout before connecting or disconnecting a 
target from the local port. 
1. Connect the cabled target to the local port of the readout 
2. Press and hold the MENU button for approximately two 

seconds to enter configuration mode. 
3. Set the Measurement Units 

Press the MENU button until the upper display shows   Use the UP and DOWN arrow 
keys to select either   for inches or   for millimeters. 

4. Set the Dampening Level 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow 
keys to set the number of averages. Adjust this value as required to suit the application. The 
default for this application is 8. For long distance shots, use 16 or 32.  

5. Set the Readout Function to Local Target 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow 
keys to select  . 

6. Select the PSD descriptor applicable to your target 
Press the MENU button until the upper display shows    , where  designates the 
target calibration factor number. There is one calibration record for each target purchased. The R-
1307 can store up to 9 records.  Each calibration record in the R-1307 has the following target 
types:   
• TGT=0 (for HLI use only. Do not use ) 
• TGT = nn, P.10.10 (10x10 mm sensor-  pulsed beam mode) 
• TGT = nn, F.10.10 (10x10 mm sensor- fixed beam mode) 
• TGT = nn, P.4.4 (4x4 mm sensor- pulsed beam mode) 
• TGT = nn, F.4.4 (4x4 mm sensor- fixed beam mode) 
• TGT = nn, P.20.20 (20x20 mm sensor- pulsed beam mode) 
• TGT = nn, F.20.20 (20x20 mm sensor- fixed beam mode) 
• TGT = nn, P.40.40 (40x40 mm sensor- pulsed beam mode) 
• TGT = nn, F.40.40 (40x40 mm sensor- fixed beam mode) 

nn= R-1037 Readout number and matching target number  
Press the UP or DOWN arrow to select the correct target number, which will change the second window. 
For example,   or   for R-1307 #2. The PSD sensor size and type are 
fixed to the target calibration record.  

 
Figure 3 – R-1307Readout 
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Warning! 
Targets are matched to specific calibration records in the R-1307 Readouts. For example, Target #1 
must be connected to Calibration Record #1 in the R-1307 or the calibration is void.  
 
Up to 9 different target calibration records can be stored in each R-1307.  When there are multiple 
calibration records, the record ID must match the target ID, so if you have Target #1,  select TGT=01 
to select the matching calibration factors.  
The R-1307B version of the readouts can only save one target calibration record, so each R-1307B 
readout must be matched up the target the calibration factors were generated with. 
 
7. To exit configuration mode, press and hold the MENU button for approximately three 

seconds until the display returns to normal mode.  
The R-1307 will also return to normal mode automatically after approximately four seconds of 
inactivity.  
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Hardware Configurations 
 
Pre-installing the Common USB Port Driver (A-910-2.4ZB) 
 
This driver is required for the A-910-2.4ZB Transceiver in order to communicate with targets via the 
computer’s USB port. The driver creates a virtual COM Port that is recognized by the applications as a 
standard serial port.  
Note:  You must pre-install this driver prior to connecting the A-910-2.4ZB Receiver (s) to the 
computer through the USB port.  
 
Installing the Driver  
1. Insert the USB Flash Drive into an available USB Port. 
2. Select My Computer, locate the Removable Disk (Flash Drive) icon and click to open it.  
3. Select the USB Common Drivers folder. 
4. Locate the CP210x_VCP icon and click to initiate the installation process. The Install Driver dialog 

box displays. 
5. Select the Windows operating system installed on your computer and open the folder. 
6. Click Browse to select an installation folder different from the default folder (optional). 
7. Click Install. Once the installation is complete, the Installation Successful message displays (see 

Figure 4). 
 

 
 
Figure 4 – USB Common Driver Installed 
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Configuring the Hardware and Utility Settings 
 
Insert the A-910 ZB dongle into any unused USB Port. The computer should 
automatically assign a COM port number to the dongle.  
 
1. Start the A-910 Utility Software. The software should display the COM port 

assigned to the Zigbee Dongle (see Figure 6). If the utility does not 
automatically detect the COM port, it must be manually selected (see 
Appendix E - Manually Selecting a COM Port on Page 60). The Target 
System ID or R-1307 CH (channel) is the number 
associated with the A-1519/1520 targets or R-1307 
Readout. If using both the A-1519/1520 targets and an 
R-1307 Readout, both need to be set to the same 
system ID and channel (see Figure 7).  

 
  
 
 
 
 
 
 
 

 
 
 
Figure 7 – Setting the Targets/Readout to the same System ID and Channel 

 
Figure 5 – A-910 Zigbee Dongle 

Figure 6 – A-910 Utility showing the COM Port, System ID and 
Channel Settings 
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Installing the Bore9 Alignment Software 
 
System Requirements 
1Ghz minimum, 1G RAM minimum (2G RAM recommended), 1.1G free disk space, Screen Resolution 
1024x768 minimum. 
 
Installing the Bore9 Alignment Software 
 
The following Microsoft Windows® operating systems have been tested with Bore9: 
 
The following Microsoft Windows® operating systems have been tested with Bore9: 
Windows XP Professional 2002 SP3, Microsoft Vista Business SP1, Windows 7 Ultimate x64, Windows 
7 Home Premium SP1, Windows 7 Professional, Windows 8 Pro and Windows 10 Pro. 
 
Note: In addition, software for reading .pdf files, such as Adobe Acrobat, is necessary in order to access the 
program documentation and read alignment files saved in this format.  
 
Note:  
Before installing the Bore9 software, ensure that your computer has the latest Windows Service Pack and 
critical updates. To find security updates, visit www.windowupdates.com. If you are installing on 
Windows XP 64 bit you might need to install the Windows Imaging Component.  
 
The Windows Imaging Component 32-bit can be found at:  
http://www.microsoft.com/en-us/download/details.aspx?id=32.  
The Windows Imaging Component 64-bit can be found at: 
http://www.microsoft.com/en-us/download/details.aspx?id-1385. 

 

http://www.windowupdates.com/
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Installing Microsoft .NET Framework 4 
 
You must have Microsoft .NET Framework installed before installing the Bore9 software. If you are 
unsure about whether you have Microsoft .NET Framework 4 installed on your computer, open the 
Control Panel. For Windows XP users, select Add/Remove Programs; for Window 7 users, select 
Programs and Features. Scroll down the list of installed software to locate Microsoft .NET Framework 
4.  If the program is not installed, follow the instructions for installation on Page 10. 
 

 
 
 
1. To install Microsoft .NET Framework 4, locate the folder 

MS_Framework_4_X86_X64 on the Bore9 installation 
CD. Open the folder and double-click 
DOTNETFX40_FULL_X86_X64 to begin the 
installation.  Follow the on-screen prompts to complete.  

 
 
 
 
 
 
 
 
 
2. When the installation is complete, click Finish to close the 

installation program.  
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Installing Microsoft Access Database Engine 
 
The Microsoft Access Database Engine must be installed on your computer before installing the Bore9 
software. This file is usually on your computer if you have a full version of Microsoft Office installed.  
 
If you do not have MS Office installed, then do the following: 
 
1. Open the folder on the Bore9 installation CD 

called MSAccessDatabaseEngine. Double-
click the file AccessDatabaseEngine to begin 
the installation. 

 
 
 
 
 
 
 
 
 
 
 
 
2. When prompted, check the box to accept the 

terms in the License Agreement and select Next 
to continue. 
 
 
 
 
 
 
 
 
 
 
 

3. Choose the location to install Microsoft Office 
Access Database. The default location is 
automatically selected. To change the 
installation location, select Browse and specify 
a folder. Select Install to continue. 
 

4. When installation is complete, click Finish. 
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Installing Bore9  
 
1. Insert the USB flash drive provided into the USB port on the laptop or tablet PC.  
2. If your system is configured to do so, the AutoPlay 

window displays. Click Open folder to view files.  
3. If the AutoPlay window does not display, click Start>Run. 

Click Browse>My Computer and select the USB flash 
drive.  

4. Double-click the MS_Framework4_x86_64 folder and 
click dotNetFx40_Full_x86_64.exe to begin installation. 

5. When finished, return to the main folder and double-click 
the MSAccessDatabaseEngine folder. Click 
AccessDatabaseEngine.exe to install. Return to the main 
folder. 

6. Click setup.exe to begin the Bore9 installation. 
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What is Bore Plot? 
 
Bore Plot measures and displays the alignment of multiple bores. It measures bore straightness (axis 
centering) and size (diameter) using one of the bores as a reference. Applications include turbines, engine 
blocks, rotary compressors, extruder barrels, gun barrels, hydraulic cylinders and printing press bearings. 
 
Continuous vs. Individual Bores 
 
Continuous bores, such as rifle barrels, are single bores whose 
lengths are comparatively greater than their diameters. 
Measurements are taken by selecting points along the length of 
the continuous bore and taking readings at these cross sections. 
 
Individual bores, such as bearing mounts in an engine block, are 
separate from one another and usually have lengths which are 
comparatively shorter than their diameters.  One reading is 
taken at the center of each bore.  If the bore is very narrow, the 
target may need to be mounted to a face and centered. 
 
 
Error Correction: The NORMIN Procedure 
 
In order to get accurate results, target mounting, and other errors must be compensated for in some 
fashion. The NORMIN Procedure was developed as a way of canceling out these errors.  It is used in 
conjunction with simple fixtures and targets which allow inexpensive, precision measurement. For an in-
depth discussion of the NORMIN Procedure, see Appendix A beginning on Page 54.   
Measuring Alignment and Size 
 
• To measure alignment of several bores, the laser should be bucked into (made parallel to) the two end 

bores. The target is then moved from bore to bore, and the deviation from the end bores is the 
measure of the misalignment of the bore. For the most accurate results, the same target should be used 
for all of the bores. 

 
Note:  The NORMIN procedure is necessary when performing bore measurement with any target. 
The NORMIN procedure is necessary for performing bore alignment with all bore targets except the 
A-510, A-512 and A-516 Self-Centering Targets.   

• To measure the sizes of several bores with respect to a reference bore, a reference bore with a known 
size is selected.  The same target is moved from bore to bore (taking care to square up the target as 
closely as possible), taking error correction readings.  The program calculates and displays the actual 
diameters of the individual bores.  
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The following are the steps common to the different types of bore measurement:  
Hardware Setup 
There are two ways of setting up Hamar Laser’s bore alignment lasers: 
1. External Mount - This method uses the L-111 Laser Stand and the L-102 Beam Translator to mount 

the laser outside the end bores.  A target is moved from the near to far bores and the Buckin 
procedure is used to align the laser to the end bores.   

2. Internal Mount - This method uses the L-708 Laser with the A-514 Self-Centering Bore Adapters to 
mount the laser in first end bore. The A-512 Target and a second A-514 Self-Centering Adapter is 
mounted in the second end bore.  The laser is then tilted (steered) until the readout shows zero.    

Bucking In 
The Buckin procedure is needed to align the laser to bore reference points (or a spindle axis of rotation) 
so the alignment of other bores can be checked. The laser is positioned by adjusting the laser beam (using 
a beam translator) to center on the near target, and then adjusting the laser itself to point the beam on the 
target in the far position. This is repeated until the target gives the same reading in both positions. 
 
Bore Setup  
The user enters information In the Bore9 Setup Screen, such as the number of and distance between 
bores, the diameter of the reference bore, and the spacing between points to be measured.    
 
Recording Data 
The user moves the target from bore to bore, taking data. Data may be taken in any order desired, but the 
simplest way is to measure bores in numerical order). When taking NORMIN readings to cancel out 
errors, both the NORMal and INverted readings can be taken for one bore before moving to the next or 
the NORMal readings can be taken for each bore in one pass, and the INverted readings in the next.     
Plotting Results 
The resulting data is displayed on the screen as a two-view graph.  
 
Saving, Printing, and Reviewing Results 
Data may be saved and customized for review and for generating a printed report.  
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Getting Started with Bore9  
 
Hamar Product Registration 
 
In order to protect against software pirat-
ing, we have implemented a simple prod-
uct registration procedure. After a Hamar 
product is installed and when the program 
is run for the first time, the user is prompt-
ed to enter the Product Registration Code 
(see Figure 8). To obtain the Product 
Registration Code, send the PC ID Code 
(automatically generated) displayed on the 
screen to Hamar Laser Support 
(Support@hamarlaser.com). A Hamar rep-
resentative will issue a Product Registra-
tion Code via email  to complete the regis-
tration process. Enter the Product 
Registration Code and click Register 
Product (see Figure 9). The product is now 
registered.  
 
 
 

 
 
 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 9 – Enter Product Registration Code 
 
To begin using Bore9, double-click the Bore9 icon or select the program from the Windows Start Menu. 
The initialization screen displays, providing the number of the current software version.  

Figure 8 —Product Registration Screen 

mailto:Support@hamarlaser.com
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Creating a New Project File or Opening an Existing 
Project File 

 
When the Bore9 software opens, the Project Selection screen 
displays. Here you can either open a saved project or create a new 
project. This screen can also be accessed by clicking Open Project 
from the File menu.  
 
 
 
 
 
 
 
 
To create a new project, click New Project and enter a 
project name.  
 
 
 
 
To open a saved project file, click Open Project from the File 
menu.  Double-click on the project folder and then click on the 
*.prj file to open the project. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

  Figure 10 – The File Menu  
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Standard Features of the Bore9 Screens 
 
Bore9 is structured to guide the user through the setup and data taking process.  There are 5 steps to 
collecting bore straightness data: 
 
Step 1 – Bore Setup (beginning on Page 26) – enter setup information for the alignment check such as 
number of bores, distance between bore, bore diameters and bore straightness tolerances. 
 
Step 2 - Target Mounting Error (beginning on Page 30) - an easy procedure is followed to remove the 
mounting errors of the target if desired. 
 
Step 3 – Laser Setup (beginning on Page 31) –on-screen instructions guide the user through setting up 
the laser and making it parallel to reference points. 
 
Step 4 – Record Data (beginning on Page 41) – bore straightness data is recorded.  There are several 
different sets of data that can be taken here. 
 
Step 5 –Results (beginning on Page 46) –results of the data are plotted on a graph and a least-squares, 
best-fit data algorithm is applied to generate the straightness results and to determine if they are in or out 
of tolerance.  Reports are also generated in this step. 
 



 

 18  

The Menu Bar 
 
The Menu Bar in the Bore9 program is located at the top of the screen under the program banner. The 
options are File, Navigate, and Help (Alt-H). Click with the mouse on one of these options to view the 
associated drop-down menu. 
 

 
 
Figure 11 – Bore9 Menu Bar 
 
Once a Menu Bar dropdown menu opens, you can access any item on the menu by clicking it once with 
the mouse.  
 
The File Menu 
 
Open Project  Opens folder for user to select project to open. 
Close Project  Closes currently open project. 
Save Project  Saves current project. 
Preferences Contains tabs for user to enter Company information, 

Units, Data Grid Displays, Decimal Displays, Target 
Setup and Record Mode. 

View Comm Port… Click here to see if data packets are coming in to Bore9. 
Exit Bore9 Stores all current settings, prompts the user to save any 

unsaved data, and exits the Bore9 program.  
 
 
The Navigate Menu 

 
Bore Setup Displays the Bore Setup 

screen (Step 1 on Page 
26). 
 

Mounting Error Displays the Target 
Mounting Error screen 
(Step 2 on Page 30). 
 

Buckin  Displays the Laser 
Buckin screen (Step 3 on 
Page 31). 

Record Data Displays the Record 
Data screen (Step 4 on 
Page 41). 

Results Displays the Results 
screen (Step 5 on Page 
46). 

 
The Help Menu 
 
User Guide Displays the User’s Guide. 
About  Displays the software information.  
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Navigating in Bore9 with the Status Bar 
 

 
Software Steps 
Click any number on the Status Bar to navigate to that step in the software.  The right arrow and left 
arrow advances to the next screen. 
 
Notes  
Click Notes in the Status Bar to open a place to 
enter notes for the alignment.  This information 
is printed in the report. 
 
Units 
Displays the measurement units selected in 
Preferences-Units (see Page 25). 
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Target Setup 
 
When you buy a new system from HLI, 
your target setup should already be pre-
configured into Bore9. If so, then please go 
to Step 1—Setup on Page 26 to select the 
target.  
 
If the target setup data has not been 
entered, click File>Preferences>Target 
Setup. Click New Target to specify and set 
up a computer interface and to select a 
target that reflects the type of work being 
performed. 
 
 
 
 

 
1. Select the type of Computer Interface you are using and 

click Next.    
Note: If you are using an R-1307-2.4ZB Wireless 
Readout, select A-910-2.4ZB.  If you are using the R-
358 Computer Interface, select R-358HR. The R-358SR 
is for legacy customers who still have the discontinued 
R-355D. 

 
 
 
 
 
 
 
 
 
 
 

2. Select the target you are using and click Next.  Hover the mouse 
cursor over a picture of a device to enlarge the picture.   
Note: It is VERY important to match up the target part number to 
the target you are using.  The most important factor is the size of 
the PSD.  Therefore, if your target has a 10x10 mm PSD, do not 
select any targets that have either a 20x20 mm PSD or 45x45 mm 
PSD.  If you do not match the target PSD’s correctly, errors 
display in the data. 
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3. A popup displays asking you if you want to load 
calibration factors.  If you have a disc with your 
Target File, you may load it now. Click Yes to 
load your configuration files. Select No to 
continue if you do not have a Target Files.  
Note: This is only needed for the R-358 Computer 
Interface.  

 
 
 
 

4. If you clicked No, enter the required infor-
mation: Target Name, Calibration Date, Target 
Network ID, (see Setting the Target System ID 
and Target Network ID on Page 60) and de-
pending on your target, the Calibration 
Constants. The Serial Number, Focal Length and 
Description are optional. Note that the Name 
field can contain any name that will readily 
identify the target.  

 
 
 
 
 
 
 

When using cabled targets, the Target Network ID field is replaced 
with DC Plane. 
 

 
 

Calibration Constants 
 
If using the R-1307-2.43ZB/A-910-2.4ZB, you do not need to load any 
calibration constants.  It is only for the R-358 that calibration constants are 
required.    
To load calibration constants, click Load Target File… to load the 
calibration constants for the target specified in the Target Setup.  These files 
are found either on the CD that is sent with a target or in a folder where 
they’ve been copied to your hard drive.  
 
You can also enter calibration constants from your calibration report.  To 
enter the factors, click on one of the four Center Entry Boxes.  You will get a 
message asking if you really want to make changes.  Click Yes.    
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Notes:   
• When entering the calibration constants from a printed list, click on each field and enter the value 

manually.   
 

• Be very careful entering the Calibration Constants, 
since they can have a big influence on the values and 
entering a wrong value will cause big errors in the data.  
The standard range for calibration constants is 0.9 to 
1.1.  Any numbers outside of this range should be viewed 
with caution and it is recommended to contact Hamar 
Laser to confirm they are ok to enter.   

 
5. Click OK to save the settings. In Step 1: Setup the target will display in the drop-down menu in 

Select Targets to Use shown on Page 26.   
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Setting R-1307 Target Network ID to Match the Settings in Bore9 Target 
Setup  
Setting System ID (Radio Channel) for the R-1307 
Press MENU until the upper display shows   , with the current System 
ID () blinking. Use the UP and DOWN arrow keys to set the System ID. 
NOTE:   must be set to the same number as the channel switch setting of the A-910 
Zigbee Dongle or A-910 Radio Transceiver (see Appendix B beginning on Page 56.  
MENU provides access to the operational functions of the R-1307, such as 
display mode, measurement units, dampening, display resolution and display 
brightness. In addition, communication parameters between the target and 
readout are set through MENU. 
 
1. To use MENU, press and hold the key for two seconds to enter 

Configuration Mode, and then press MENU to cycle through the 
selections. Press the UP arrow key (↑) or the DOWN arrow key (↓) to 
change the settings for a selection.  

2. Press MENU until the upper display shows   with the current Target ID 
() blinking. Use the UP and DOWN arrow keys to set the Target ID to match the 
setting of the upper display ID. 

3. Press MENU until the lower display shows   with the current Target ID 
() blinking. Use the UP and DOWN arrow keys to set the Target ID to match the 
setting of the lower display ID. 

 

  

  
NOTE: The TNID (Target Network ID) allows the hardware and software to 
communicate. If the TNID is not set correctly, the user receives no communication. 
Each Step in Bore9 requires the user to select the correct TNID, however once the 
TNID is selected in Step 2, it should remain selected through the following steps. 
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Preferences  
 
Decimal Display 
 
Select the desired number of decimal points to be 
used for alignment data displays.   
 
 
 
 
 
 
 
 
 
Company Information 
 
Enter company contact information for the reports 
here.  If you click Include Logo in Reports and then 
click Browse, you can import a company logo to 
display on the report.   
 
 
 
 
 
Data Grid Display 
 
This tab includes several options that control how 
Bore9 takes data and what analysis data is displayed 
in Step 4–Record Data (beginning on Page 41).  
 
For most standard bore straightness applications using 
HLI’s self-centering targets, click Normal Target 
Readings – Center.  .  
 
When using non-self-centering bore targets or using 
the self-centing targets in Measure Mode, select 
Inverted Target Reading – Center.   If diameter 
change calculations are needed, then select Diameter 
to calculate bore diameter changes.  In this case, you 
are required take a NORMal and INverted reading at 
each bore location.  This allows the software to 
remove any mounting errors (TSCE) in the fixturing 
and also calculate the bore diameter change (if a 
reference bore diameter was entered in Step 1: Setup 
on Page 26). 
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Units  
Select Imperial (inches) or Metric (mm) and units for any slope calculations.  The Slope/Angular units are 
used only in the Results Summary in Step 5:  Results and in Bore9 Report where Bore9 shows the results 
of the slope of the Least-Squares, Best Fit line.  The angular format is in/ft for Imperial and mm/m for 
Metric. 
 
 
 
 
Record Mode  
Select the number of data samples for each value in the 
data displays, as well as a date and time stamp and 
comment for each data point.   For the two-target 
configuration, you may set the averaging differently for 
each target. 
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Setting up a Bore Alignment Project 
 
Step 1 - Setup 
 
Enter the setup information for the bore alignment project, such as number of bores, distance between 
bores, targets being used, tolerances, etc.  

  
 
Select Target to Use  
Select the target(s) to be used in the alignment setup. If the target you are using is not in the dropdown 
list, go to Preferences>Target Setup to add your target (see Target Setup on Page 20).  

   
Number of Targets  
For most bore applications, you will use only one target. Select a specific target by clicking the dropdown 
list for Target A.  
 
To add a second target, for 2-target bore applications, click on the Target B dropdown list and select the 
target and dbID. When using 2 targets, Target A is used in the Near Bore and Target B is used in the Far 
Bore. The procedure for using two targets is explained in Taking Data in Step 4 (Two Targets) 
beginning on Page 42. 
 
Note:  Two targets can only be used with wireless technology. It is not possible to use two targets with an R-358 
interface. You cannot select the same specific target for the A and B targets. 

Figure 12 – Initial Bore Plot screen with Bore Setup 
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Interpreting Target Data Signs (+, -) 
 

 
Number of Bores  
Enter the number of points to be measured, either by typing in the number or using the up/down arrows. 
A minimum of three and a maximum of 50 points can be specified.  
Bore Spacing  
Specify whether the bores to be measured are 
evenly or unevenly spaced. If they are evenly 
spaced, enter the common distance (spacing) 
between points and press Apply.  
 
If they are unevenly spaced, select the Set Uneven 
Spacing button to enter the distance between 
individual points in the grid.   

 
 
 
To enter a value, click in the up/down 
arrows to select the starting and 
ending bores, then enter the value in 
the Distance box.  Click Apply to 
save.  To close the entry window, hit 
OK.  You can also enter values 
directly into grid box in the table. 
 
Note:  The words Even or Uneven 
display to indicate which spacing method 
was chosen.   
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Reference Bore Diameters  
If measuring several bores with respect to a reference bore, select the 
number of the bore to designate as a reference and supply its actual vertical 
and horizontal diameter. 

 
 
 
 
Laser Position  
Click on the graphic to select direction the laser is facing (left or right). 
 
 
 
 
 
 
 
 
Tolerance Bands  
When the Tolerance Bands feature is ON in Step 5: Results and a tolerance 
number is assigned, the graphs in Step 5 (see Page 46) indicate whether the 
overall straightness (the acceptable straightness misalignment tolerance over 
the whole range of data points) and bore-to-bore straightness data is within the 
values specified.  
 
Bore-to-Bore  
This tolerance is the acceptable deviation tolerance from one bore to the next 
bore.  This applies to either Concentricity or Straightness formats in Step 5. 
 
Concentricity 
This is the tolerance for the maximum allowable concentricity change from the 
lowest to highest value.   
 
Straightness 
 
The overall TIR straightness tolerance for the data.  All the data points need to fall within the ± tolerance 
band to be in tolerance. 
 
Reference Target 
Enter a tolerance for the reference target when taking data in Step 4 using two targets, where one target 
(reference) is used to monitor laser drift.  If the display values exceed the tolerance entered here, the 
Reference Target display turns red.  
 
  



 

 29  

Graphing 
When viewing the alignment graphs in Step 5, a 
green tolerance band indicates the overall bore 
straightness tolerance. If a data point falls outside of 
this area, it is out of overall tolerance.  For bore-to-
bore tolerance, a red dotted line between 
measurement points indicates an out-of-tolerance 
bore-to-bore condition between those two points.   
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Step 2 – Target Mounting Error 
 
The Target Mounting Error uses NORMIN readings to determine 
mounting and other errors in a fixture-mounted target and adjusts 
the display to remove the error from the readings. The user is required to take two data points:  1) with the 
target in the NORMal position; and 2) with the target in the INverted position.  The software calculates 
the mounting error and then applies it to the displayed and recorded data to remove the mounting error 
from all data points.  This is a global target offset and is applied to all data unless it is turned off.   
 
Note:  When using A-510 or A-512 Self Centering Targets with the L-111 Laser Stand, you can skip this step since 
any centering errors are identical for the reference points and the measurement points.  Since Bore9 uses the Least-
Squares, Best-Fit data analysis, the centering errors are not important when measuring straightness or alignment 
for bores when using the end bores as a reference.    
1. Coarse-align the laser and target on the numerical display. 

Ensure that that laser and target are in position and the numerical display is showing readings.  
 
2. Select TNID (Target Network ID). 

Using the drop-down arrow, select the TNID for the target you are 
using to perform the mounting error.  This number should match the 
one in the R-1307-2.4ZB readout (see Page 23).  Normally this is 
not changed. 
 
 

 
3. The graphic showing the target with an I displays the proper 

orientation of the laser and target for taking the first reading.  This 
means to invert the target, so the cable is at 12:00. 

 
4. Click Record to take a reading.  

Ensure the target and fixture or bore adapter have been 
rotate to the INverted position. Click Record or press 
the spacebar to take a reading at the current position of 
the target and laser. The cursor moves automatically to 
the next field in the table and the graphic showing the 
laser and target orientation changes.  

 
5. Return the target to the NORMal position. 

Rotate the target to NORMal position and level. (The target 
graphic now shows the letter N). 

 
6. Click Record to take a reading.  

Press Record or press the spacebar to take a reading at the 
current position of the target and laser. Wait until the program 
takes all of its samples and displays the readings before 
performing the next step. Bore9 automatically calculates the 
mounting error offsets and applies them to the displayed 
reading.  You will see the Offsets button show ON, indicating 
there are offsets being applied.    
The plot screen now reads the laser beam position (less 
fixture mounting errors). The Offset button and Status Bar 
indicate that Target Mounting Error offsets are ON. Any 
further readings display with this value subtracted. 
 
To turn off the Mounting Error Offset, click the ON button.  The display offset is removed. 
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Step 3 – Buckin (Laser Setup) 
 
Buckin (laser setup) calculates set points for making a laser parallel to two reference points, usually the 
end bores.  Use the Step 3: Buckin Wizard to guide you through the Buckin process. 
 
While performing Step 3: Buckin, the following options are available: 
 

 
 
Restart – click to restart the Laser Buckin procedure. 
Record – click when instructed to record data for laser setup. 
Previous – click to return to the previous steps of the procedure. 
Next – click to proceed to the next set of steps in the procedure. 
Finished – Next becomes Finished when the last steps of the procedure display.  Click Finished to 
proceed to Step 4: Record Data. 
 
Laser Mounting Options 
 
There are three ways to set up the laser:  

1. Extruder Mount - Select Extruder Mount if using the L-705 to align an extruder barrel to the 
gearbox.   

2. Internal Mount - Use Internal Mount if using the L-708 Laser with the A-514 Self-Centering 
Adapters or if using any bore laser mounted directly in a spindle. 

3. External Mount - Select External Mount if using the L-705/L-706/L-708 with the L-111 Laser 
Stand and L-102 Beam Translator.  

 

  
Figure 13 – Bore Setup Display showing Extruder Mount 
 

 
 
Figure 14 – Bore Setup Display showing Internal Mount 
 

 
Figure 15 – Bore Setup Display showing External Mount 
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Step 3 -- Extruder Mount  
 

 
 
1. Select the laser mounting by clicking the Extruder Mount graphic. Click Next.  
 
2. Place the A-705 Chuck Fixture into the counter bore in the gearbox and tighten in place.  Place 

the L-705 into the A-705 and rotate it so the top level is centered in the circle (Appendix H 
beginning on Page 70 or L-705 Extruder Manual for more details). 

 
3. Perform a Rough Buck-in of the laser to gearbox AOR to get the laser roughly aligned to the 

AOR.   
 
4. To perform the Fine Buck-in, rotate the gearbox spindle 

(with the A-705/L-705) 180 degrees to the INverted 
position, making sure to center the bubble in the circle.  
Click Record.  

5. Rotate the gearbox spindle (with the A-705/L-705) 180 
degrees to the NORMal position, making sure to center 
the bubble in the circle.  Click Record. 

 
6. Bore9 calculates a Set Point, which is the average of the 

two sets of readings.   
 
 
 

7. Turn the Vertical micrometer on the L-705 until the V 
display equals the Vertical Set Point, and then turn the 
Horizontal micrometer until the H display equals the 
Horizontal Set Point.  

8. The laser is now bucked-in to the gearbox axis of 
rotation (AOR).  

9. Repeat Steps 1-6 to verify the laser is bucked-in.  
10. Go to Step 4: Take Data. 
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Step 3 -- Internal Mount Laser – L-708 Bore Laser 
 

1. Select the laser mounting by clicking the 
Internal Mount graphic. Click Next.  

2. Select the target to use for the laser setup. If 
using one target, select Target A for the 
laser setup. If you have two targets, select 
Target A or Target B for the laser setup.  
Click Next. 

 
Note: For internal mount, you cannot 
choose A+B.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Follow the on-screen instructions to perform the laser setup.  

 
 

4. Click Finish to go to Step 4: Record Data on Page 41. 
 
 
 
 

 

Target A Selected Target B Selected 
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Step 3 -- External Mount Laser Procedure – L-706/L-708 Bore Lasers + L-111 Laser Stand + L-102 
Beam Translator 

 
1. Select the laser mounting by clicking the 

External Mount graphic. Click Next.  
2. Select the target to use for the laser setup. If 

using one target, select Target A for the laser 
setup. If you have two targets, select Target A 
or Target B for the laser setup.  Click Next. 
 

 
 

3. Enter D1 distance from the L-111 Pivot Point to the Target in the Near bore and the D2 distance 
from the near bore to the far bore, as shown in the graphic on the screen (also see L-705/L-706 
General Bore Alignment manual for more details). 

 

 
 

 
 
For example: 
 
Distance from Laser Pivot to Near Target D1 = 4.46 
Distance from Near Target to Far Target D2 = 12.67 

 
4. Follow the on-screen instructions to record data for Near Point and click Next. 
 
 
 

1.  
2.  

 
3.  

 
4.  
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Data for the Near Target are displayed in Results and highlighted by a green background. 

 

 
 
5. Follow the on-screen instructions to take data for the Far Target and click Next. 
 

 
 
Data for the Far Target are displayed in Results and highlighted by a green background. 

 

 
 
 
6. After clicking Next, the Laser Set Points are calculated and highlighted in yellow in Results.   
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7. Follow the on-screen instructions to steer the laser beam so that the V and H displays match the V 
and H Set Points.   

 
 

 
 
8. If the display does not show zero after moving the target back to the Near Bore, repeat the above 

steps until the target displays zero in both the near and far bore locations.   
9. When the target reads zero in both locations, then you are ready to move on to Step 4 to take 

data. 
  



 

 37  

Step 3 -- External Mount Laser Procedure with 2 Targets –L-706/L-708 Bore Lasers + L-111 Laser 
Stand + L-102 Beam Translator 
 
Bore9 gives you the flexibility to use 2 targets for the buck-in for those applications where it’s 
hard to move the targets to the near and far bores.  Normally this would require one of our “see-
through” targets, the T-218, T-1220 or T-1240 targets.  Here is a procedure to use two targets for 
the buck-in. 
 
1. Going back to Step 1, you can select 2 targets to be used for setting up the laser. Target A is used in 

the Near Bore and Target B is used in the Far Bore.  
 

 
Note:  Two targets can only be used with the R-1307B-2.4ZB  technology. It is not possible to use 2 targets with 
an R-358 or R-358 HiRes interface. You cannot select the same specific target for the A and B targets. 

 
2. If using the T-218 Bore Target + T-225L Large-Bore Adapter, you will need to remove mounting 

errors from the target.  If not using this target, then skip to Step 8. 
 

3. Go To Step 2.  Click on Select Target A to work on Target A. For 
Target A Rotate the target to the inverted position and insert it into 
the Near Bore. Click and then click Record for the Target A data 
box.  

 
 
 
 
 
 
 
4. Rotate Target A to the normal position. Click Record for the 

Target A data box. This automatically calculates a display offset 
that is applied to raw values for Target A. 
Note: The calculated offset is the target mounting error and it is 
subtracted from all readings taken with Target A.  
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5. Click on Select Target B to calculate its mounting error 

offsets. 
6. Rotate Target B to the Inverted position, insert it into the 

Far Bore and click Record 
 
 
 
 
7. Rotate Target B to the Normal position and click Record.  

This automatically calculates a display offset that is applied 
to raw values for Target B. 
Note: The calculated offset is subtracted from all readings 
taken with Target B. 

 
 
 
8. Click 3 at the bottom of the screen and select External Mount to display the Buckin Wizard 

(External Mount/2 Targets). Click Next. 

 
 
9. Select A + B and click Next. 
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10. Enter the distance from the laser pivot to the Near Target 
and the distance from the Near Target to the Far Target 
(see graphic at the bottom screen to see how to measure 
the dimensions – shown here).  Click Next. 

 
 
 
 
 

 
 
 
11. Ensure that Target A is mounted properly in the Near Bore and Target B is mounted in the Far Bore 

as displayed on the screen. Click Next. 
 
 
12. Following the on-screen instructions, we then Adjust L-102 Beam Translator until Target A’s value is 

zero.  Click Record 

 
 
13. Flip the T-218 Target’s prism out of the way to allow the beam to pass through to Target B.  Then 

click Record.  This will calculate Set Points for the Far Target B.  We want to adjust the laser to 
those Set Points. 
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14. Adjust the H and V knobs on the L-706/L-708 until the Target B display values equal the Set Points. 
 

 
 
15. Flip the prism on the T-218 Target back into the laser beam and note the reading.  The readings 

should match the Set Points.  If not, they will be close.  Repeat Steps 11-14 to fine tune the setup to 
get it closer to zero. 

16. If the readings match to the Set Points or are very close, you can move on to Step 4. 
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Step 4 – Record Data – Single Target 
 
Once the laser is bucked in, we can begin taking data.  Normally a single target is used to take the data. 
 

 
 

Figure 16 – Record Data screen 
 
Recording a Data Point  
To take a data point, press Record or press the space bar.  The point will show up in the box selected.  
The default position is Bore #1. 
 
Auto Step  
Auto Step automatically moves from one point to the next, either 
in NORMal Mode, INverted Mode, or in both modes. Check the 
box marked Auto Step to toggle the Auto Step feature on and off. 
When Auto Step is ON, the cursor automatically advances to the 
next position when data is recorded. When Auto Step is OFF, 
data records at the same position and overwrites the previous data recording. Disabling Auto Step allows 
the user to move the target to a point where data has previously been recorded, select that point on the 
plot and retake the reading.  
 
Direction  
To change the direction to record data, click the left or right Direction arrow in the 
Auto Step area of the screen.  
 
Re-Recording Data Points 
To re-record a data point, click on the point in the data table and 
press Record.  Bore9 will then ask if you want to overwrite that 
point.  Click Yes to accept and No to not record. 
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The Target Orientation, Measure Target and Laser Position icons illustate the settings being used by 
the software. 
• When clicking on a NORMal data point in the grid table, 

Target Orientation shows an image of the target with an  
N on it. 

• When clicking on an INverted data point in the grid 
table, Target Orientation Orientation shows an image 
of the target with an I on it. 

 

 
 
 
Taking Data in Step 4 (Single Target – typical use) 

 
1. Select the Auto Step method to use in the Auto Step box at the bottom of the screen – normally this 

defaults to Normal Only. 
2. Insert the target/adapter into the first bore.  Click Record or press the spacebar to record the data 

point.  The green highlight box (“cursor”) will move to the next point if Normal Only in Auto Step 
is selected.  If Auto Step is Off, then click on the next point to record. 

3. Move target/adapter into the second bore and repeat Step 2 (see Page 30) to record data. 
4. Continue until all the data has been recorded. 
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Step 4 – Record Data – 2  Targets 
 
In some case, it may be required to use 2 targets to take bore data, such as in marine applications where 
the bores are in different rooms in a ship.  In this case, Bore9 needs to be put into 2-target mode by 
selecting a second target in Step 1 see page 25.  When this is done, you will see 2 readout displays.  One 
is marked “Target A” and the other “Target B”.   
 

 
 
Recording Data with 2 Targets 
 
When recording data with 2 targets, the source of the data point needs to be selected by clicking in 
Measure Target either the icon for Target A or Target B.  The default is Target A. 
 
To change to Target B, click on the greyed-out Target B image in Measure Target.  You 
will see the readout for Target A greyed-out and Target B displays normally. 
 

 
Figure 17 - Target A Selected as Measuring Target 
 

 
Figure 18 - Target B Selected as Measuring Target 
 
With the desired target selected, click Record to record the data point from that target in the grid.  You 
can switch back and forth between targets for any point in the data grid table. 
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Step 4 – Recording Alignment Data and Bore-Diameter Changes 
 
When using Hamar’s bore targets in measurement mode, the alignment data can be 
recorded as well as the change in bore diameters.  You must first measure the 
reference bore using a set of calipers.  You must measure the diameter at 6:00 and 
12:00 (vertical) and 3:00 and 9:00 (horizontal) and enter those values into 
Reference Bore Diameter entry boxes in Step 1.  You can also select which bore 
number you want to use as the reference.  All other bore diameters are compared to the Reference Bore 
Diameter to calculate the diameter shown in the data table.    
 
Note: Measuring for bore diameter changes cannot be performed with an A-512 Target in the A-514 
Adapter. These adapters are self-centering only and cannot be used for measuring bore bore-diameter 
changes.  However, you can use the A-512 with the A-512STA and A-512LTA Bore Adapters in to 
measure bore-diameter changes. Ensure that the target is inserted into the measurement mode side of the 
adapter. 
 
You can also use the A-510 Target in with the A- A-510STA and A-510LTA Bore Adapters. Ensure that 
the target is inserted into the measurement mode side of the adapter. 
 
You can also use the T-218 2-Axib Bore Target and the T-225L Large-Bore Flange Adapter.  
 
Procedure: 
 
1. Ensure all of the boxes are checked in the 

Preferences/Data Grid Display except Reference 
Target. 

 
 
 
 
 
 
 
 
 
 
 
2. In Step 1: Setup, (see Page 26) enter both a Vertical 

and Horizontal Reference Bore diameter. 
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3. Record readings in both the Normal and 
Inverted positions for each bore location 
(number).   The user can take all of the 
Normal readings (select Normal Only in 
Auto Step) and then all of the Inverted 
readings (select Inverted Only in Auto 
Step) or take Normal + Inverted readings at 
each location (select Normal and Inverted 
in Auto Step). 
 
Note:  The self-centering target adapters 
and handles are designed to firmly hold the 
target in place when inserted in the Normal 
position. When the target is inserted in the 
Inverted position, it is necessary to hold the 
pole or handle with upward pressure to 
firmly hold it in place or it will fall out. 
 

4. During the data recording you will notice that the Diameter V and H 
rows will show the word “Processing”.  This is normal.  The diameters 
will not be calculated until all the data has been taken.  When the last 
data point has been taken, the calculated diameters will appear in their 
respective rows.  This data will also appear in the data grid in the 
report and can also be viewed by clicking View Data in Step 5, which 
brings up the data table from the report. 

 

 
 

5. To view the alignment results, click 5 on the Status Bar to go to Step 5: Results. 
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Step 5 – Results and Analysis 
 
Bore9 offers several different ways of viewing and analyzing the recorded data depending on the 
application.  The alignment results are displayed in the Summary Table and tolerance bands are shown on 
the graphs.  The Overall and Bore-To-Bore tolerances are illustrated on each graph. 
 
Plot Reference 
 
Bores – Concentricity Plot – Select Bores – 
Concentricity 
This plot reference makes the designated bore 
numbers the zero point and plots the positions of the 
remaining bores in relation to selected bore numbers.  
For each bore location, the horizontal and vertical 
target-data values are converted into a radial 
measurement (length of the radius and the angle the 
radius is located).  The radial measurement 
represents the concentricity error for that bore 
relative to the reference bores chosen.  These values 
are then plotted in a single graph and a tolerance 
band (green shaded area) is shown. Any data point 
outside the green shaded area means it is out of 
tolerance for that axis. 
 
Bores – Straightness Plot – Select Bores – 
Straightness 
This plot reference makes the designated bore 
numbers the zero point and plots the positions of the 
remaining bores in relation to selected bore 
numbers. For each bore location, the horizontal and 
vertical target-data values are adjusted to the chosen 
reference bores and the results are plotted out 
individually for the H and V axes. Any data point 
outside the green shaded area means it is out of 
tolerance for that axis. 
 
 
Bores Plot - Changing Reference Bores 
 
To change the reference bores, click the up/down arrows and the reference bores change. 
The data and graphs adjust to reflect the new reference bores.  Clicking  End Bores sets 
the bore reference to the first and last bores. 
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Best-Fit Plot – Select Best Fit 
This plot shows the alignment of the bores relative to 
the Best-Fit line, which is calculated by using the 
Least-Squares, Best-Fit algorithm.  The data is then 
analyzed and overall straightness TIR values are 
calculated for the V and H axes.  Then for each bore 
location, the raw data is adjusted to take out the slope 
of the Best-Fit line and then result is plotted out (the 
Best-Fit line becomes the X axis) with upper and 
lower tolerance bands (green shaded area) for the H 
and V axes.  Any data point outside the green shaded 
area means it is out of tolerance for that axis.  
 
The Best-Fit Plot is especially useful because it 
removes any excess error in the data from the laser 
beam not being perfectly aligned to the end bores.  It 
also makes the laser setup faster since the laser beam 
does not have to be exactly centered in the bore to get accurate straightness measurements. 
 
 
Laser (Raw Data) Plot – Select Laser 
This plot shows the alignment of the bores relative to 
the laser beam (raw data) and shows individual plots 
for the H and V axes. A dashed black line indicates the 
Best-Fit line and is shown with upper and lower 
tolerance bands, which are displayed ± around zero as 
a green shaded area. Any data points outside the gray 
area indicate that the data set is out of tolerance 
relative to the laser buck-in. 
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Show Features 
To show or hide a descriptive line on the plot, either check or uncheck the 
appropriate box. 
 

Best Fit Line   
For the Laser Plot, the Best Fit line is shown on the plot as a dashed black line. 
Click on the check box to toggle the Best-Fit line on/off.   
Tol. Band  
Click to toggle the Overall Tolerance Bands (green shaded area) ON or OFF.  

 
Red Dotted Line on Graph 
A red dotted line indicates that the difference of one 
bore’s data is greater than the next bore’s data by 
more than the Bore-to-Bore tolerance.  The 
calculation compares the data from a bore location 
to the previous location.  For example a red dotted 
line between bores #1 and 2 means the data for bore 
#2 is greater than the data for bore #1 by more than 
the allowable Bore-To-Bore tolerance value. 
 
Detailed Data at Each Bore Location – Laser, 
Best Fit and Bore-Straightness 
Hover the mouse cursor over any data point to view 
the data for that point. A red square displays on the 
graph to indicate which point is selected. At each 
point, you will see: 
 

• The cumulative distance to the data point/bore  
• The Vertical Value (adjusted for the Plot Reference selected) 
• The Horizontal Value (adjusted for the Plot Reference selected) 

 
 
 

Detailed Data at Each Bore Location – Bore-Concentricity 
For the Bore-Concentricity plot, hover the mouse cursor over any data point to view the data for that 
point. A red square displays on the 
graph to indicate which point is 
selected. At each bore location, you 
will see: 

• The cumulative distance to 
the data point/bore  

• The Vertical Value (adjusted for the Plot Reference selected) 
• The Horizontal Value (adjusted for the Plot Reference selected) 
• Radius value – the converted radial value (adjusted for the Plot Reference selected) 
• Angle – the angle for the radius value 
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Other Features of the Bore Plot Screen 
 
Zooming in on Graph Data 
For a large number of data points, it may be desired to view a smaller part of the 
graph to better see the results.  To zoom-in on an area, just click and drag a box over 
the data points to zoom in to and the graph will display the zoomed-in data points. 
 
Undo Zoom  
Click Undo Zoom, to remove the zoomed in area.  
Laser Right/Left 
To change the orientation of the laser beam on the screen to reflect the physical 
setup, select Laser Right/Left. This flips the data back and forth to reflect the orientation.  
 
View Data 
Click to view the recorded data and analysis to print in the report.  Any box in the data table that is 
highlighted in red indicates that it is out of bore-to-bore tolerance relative to the bore before it.   
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Generating a Report  
Click Print Report to print the alignment report to a 
selected printer (see Figure 19).  
 
 
A report may also be saved as a .pdf file, however it 
is necessary to have software such as Adobe Acrobat 
installed on your computer in order to generate this 
type of file.  Click Print Report and select your .pdf 
generating software as the printer name. You are 
asked to specify a file name for the report (see 
Figure 20).  
 
 
 
 

Figure 19 – Printing a report to a printer 
 
 

 
Figure 20 – Saving a report as a .pdf file 
 
 
Figure 21 shows a sample 4-page report generated by the Bore9 software. 
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Figure 21 – Bore9 Report 
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Exporting Alignment Data to Excel Spreadsheets 
 

To export alignment data to an Excel spreadsheet for further analysis, do the following: 
 
1. Locate the Project Folder where your data is saved – the default is:  Documents/Bore Alignment 

Application/Projects 
Note:  When data is saved, a project folder with the name you entered is automatically created. For 
example, if you save a project named Test, a folder is created called Test that is located in My 
Documents/Bore Alignment Application/Projects.  This folder includes several files as well as the 
alignment data for the saved file.  
 

2. Open the folder and locate the file with the same name as the folder name, followed by RecordData. 
For example, for the Test project name, the Excel data filename is test.recordData.csv. Also created 
is a file called (projectname).results.csv file, which contains additional data not provided in the 
(projectname).recordData.csv file.  

 

 
 
3. Assuming you have Microsoft Excel installed, double-click the file name. This automatically opens 

Excel and displays the data.  
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Where: 
 
Distance = distance between each set of bores. 
Normal VC = the Vertical-axis misalignment data relative to the reference points chosen (Best Fit, Laser, 
Bores, End Bores). 
Normal HC = the Horizontal-axis misalignment data relative to the reference points chosen (Best Fit, 
Laser, Bores, End Bores). 
Ref. Target VC = the Vertical-axis misalignment data of the reference target taken at the same time as the 
bore misalignment data. 
Ref. Target HC = the Horizontal-axis misalignment data of the reference target taken at the same time as 
the bore misalignment data. 
Inverted VC = the inverted Vertical-axis misalignment data (if selected in Preferences). 
Inverted HC = the inverted Horizontal-axis misalignment data (if selected in Preferences). 

 
See Appendix G – Entering Data Manually in Bore9 beginning on Page 63 for instructions on how to 
enter data manually into Bore9. 
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Appendix A - The NORMIN Procedure 
 
The NORMIN method was 
developed by Hamar Laser 
Instruments as a way of 
compensating for laser or target 
mounting errors in bore or spindle 
work. The word is a contraction of 
“NORMal-INverted,” which briefly 
describes the method.  It is quite 
similar to the four clock readings 
taken with dial indicators, but uses a 
laser and a target instead. The 
NORMIN method is used in 
conjunction with simple fixtures and 
targets that allow inexpensive, 
precision measurement. The 
target/fixture is set in the bore or 
spindle in the NORMal position 
(cable down) and the readings are 
recorded. Then the target/fixture is 
rotated 180 degrees to the INverted 
(cable up) position, and a second set 
of readings is obtained. The two sets 
of readings cancel out centering 
errors and provide a very accurate 
result.  
There are three centers involved in 
bore alignments: the True Bore 
Center, the Target Center, and the 
Laser Reference Centerline. If 
mounting fixtures were perfect, the Target Center would be located at the True Bore Center, and if 
perfectly aligned, the True Bore Center would be located at the laser beam center. In reality, however, 
they seldom line up. An example of the three centers with respect to one another is shown in Figure 22. 
 
Two relationships can be calculated from these three centers and two sets of NORMIN readings: the 
Target Sensor Concentricity Error (TSCE) and the True Bore Misalignment (TBM). The True Bore 
Misalignment (TBM) is used when it is desirable to know the true bore centerline position relative to the 
laser beam center without fixture errors. Usually, the laser beam center is where a bore center should be 
located, and the TBM shows its actual location. The Target Sensor Concentricity Error (TSCE) is used if 
the operator wants to place the laser beam center exactly in the middle of a bore. 
 
The general rule is: buck in to the TSCE and measure the TBM. 

Figure 22 -- Three centers of bore alignment 
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The readout always shows the displacement 
between the Target Center and the Laser Beam 
Center. When the Target Center is not on the 
True Bore Center, the numbers and the signs 
on the readout will change when the target is 
rotated because the Target Center is moved to 
a different location in relationship to the laser 
beam.   
Figure 23 represents the target in the 
NORMal position, with the cable down. If 
each square represents .001 in., the Target 
Center is .002 in. higher than the Laser Beam 
Center (+.002 in.) and is .007 in. to the right of 
the Laser Beam Center (+.007 in.).  
 
 
 
 

Figure 23 – Target in the NORMal position  
 
 
 
 
Figure 24 represents the target in the INverted 
position, with the cable up. When the target is 
rotated, the signs on the readout are also rotated. 
Therefore, although the Target Center appears 
to be to the right of and lower than the Laser 
Beam Center in Figure 24, the vertical readings 
are positive, and the horizontal readings are 
negative. When the vertical TCE is calculated, 
(NORMal+INverted divided by 2) the Target 
Center is .004 in. higher and .003 in. to the right 
of the True Bore Center in the NORMal 
position. 
 
The table below shows the calculation of the 
vertical and horizontal TSCE values. 
 
 
 

Figure 24 – Target in the INverted position 
 
NORMal Vertical Reading   +.002 in.  NORMal Horizontal Reading +.007 in. 
INverted Vertical Reading +.008 in. INverted Horizontal Reading -.001 in. 
Total  +.010 in. Total  +.006 in. 
Divide by 2 = Vertical TSCE +.005 in. Divide by 2 = Horizontal TSCE +.003 in. 

 
If you place the Laser Beam Center exactly on the True Bore Center with the target in the NORMal 
position, the readings will show Vertical +.005 in. and Horizontal +.003 in. 
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Appendix B – The A-910 Radio Transceiver/Hub 
 
Front Panel Features 
 
1. Power ON indicator and Low 

Battery indicator 
2. Internal backup battery charging 

indicator and USB LINK 
ESTABLISHED indicator 

3. TX indicator: blinks when device is 
transmitting data to the target(s) 

4. RX indicator: blinks when the 
device is receiving data from targets 
or other transceivers. 

5. System ID setting switch: set to the 
same number as the R-1307’s CH 
(Channel) number. 

 
Rear Panel Features 
 
1. Not used 
2. USB/Data I/O Port 
3. Power Switch 
4. External power supply: required 

only for computers that cannot 
provide adequate power (5V, 400 
mA) through the USB port. 
Note: When using the USB 
Extender™ cable extension kit, plug 
the A-910-2.4 into an A/C power supply. 

5. Antenna 
 
See Appendix C on Page 58 for radio specification details. 
 

MODEL NUMBER PRIMARY FREQUENCY 

A-910-900 900 MHz 

A-910-2.4 2.4 GHz 

 

Figure 25 – The A-910 Radio Transceiver/Hub FRONT PANEL 

 
Figure 26 – The A-910 Radio Transceiver/Hub REAR PANEL 
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Using the R-1307 with a Local Target and the A-910 Radio Transceiver  
Setting the Target Network ID and System ID for the R-1307 Readout 
To make the unit visible to all other radio-enabled 
devices, you must set the Target Network ID and 
the System ID for the readout.  
1. Set the Local Readout/Target Network ID 

Press the MENU button until the upper display 
shows .  (nn is also equal to the R-
1037 number) and the matching Target 
number with the current Target ID () 
blinking. Use the UP and DOWN arrow keys 
to set the Target ID.   

 
Press the MENU button again until the lower 
display shows .  with the current 
Target ID () blinking. Use the UP and 
DOWN arrow keys to set the Target ID to the 
same value as that of the upper display’s 
Target ID.   

2. Set the System ID (Radio Channel) 
Press the MENU button until the upper display 
shows . , with the current System ID 
() blinking. Use the UP and DOWN arrow 
keys to set the System ID. 

 
Note that nn must be set to the same number as the channel switch setting of the A-910 radio 
transceiver (see Figure 25, #5).  

Miscellaneous Display Messages 
  
 
  Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
    3 dashes.  Target detected but the laser is not on target. Check laser. 
 
  Radio channel cannot be selected because no Radio is present or detected.  

Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  

 
 Indicates a problem with the connection to the Local Target’s Position Sensing Device 

(PSD). Check plugs and cable(s).             
   
  Target ‘’ descriptor does not contain target calibration data. 
 
See Appendix D on Page 59 for the complete R-1307 menu. 

Figure 27 -- R-1307 with Local Target and A-910 Radio Transceiver 
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Appendix C - Agency Certifications 
 
Agency Certifications for the 2.4 GHz Radio Transceiver  

 
FCC (United States of America) Certification 
 

Contains FCC ID: OUR-24XSTREAM  
The enclosed device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 
 

 RF EXPOSURE WARNING: This equipment is approved only for mobile and base station 
transmitting devices, separation distances of (i) 20 centimeters or more for antennas with gains < 
6 dBi or (ii) 2 meters or more for antennas with gains ≥ 6 dBi should be maintained between the 
antenna of this device and nearby persons during operation. To ensure compliance, operation at 
distances closer than this is not recommended 

 

IC (Industry Canada) Certification 

 
Contains Model 24XStream Radio (2.4 GHz), IC: 4214A 12008  
Complies with IC ICES-003 

 
 

 
 

Complies with ETSI.  France – France imposes restrictions on the 2.4 GHz band. Go to www.art-telecom.Fr or 
contact MaxStream♦ for more information. Norway – Norway prohibits operation near Ny-Alesund in Svalbard. More 
information can be found at the Norway Posts and Telecommunications site (www.npt.no). 
 
Since the 2.4 GHz band is not harmonized throughout Europe, other restrictions may apply to 
your country. 

 
Technical Data: 
• OEM radio transceiver, model number: 24XStream 
• Frequency Band: 2400.0 – 2483.5 MHz 
• Modulation: Frequency Shift Keying 
• Channel Spacing: 400 kHz 
• ITU Classification: 400KF1D 
• Output Power: 100 mW EIRP max. 
• Notified Body Number: 0891 

 
♦ The radio Transceiver contained in the A-1519/A-1520 Type II Universal Wireless Targets is manufactured by MaxStream. 
For more information pertaining exclusively to the Radio Transceiver please contact MaxStream at 1.801.765.9885 or visit their 
web site: http://www.maxstream.net 
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Appendix D – The R-1307 Menu 
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Appendix E – Manually Selecting the COM Port 
 
The A-910 Utility should automatically detect the COM Port 
upon startup. If not, use the following steps to locate the correct 
COM Port.  
Windows XP 
 
1. Right-click My Computer.  
2. Click Properties and then select the Hardware tab.  
3. Click Device Manager.  
Windows 7 
 
1. Click the Start button and select Control Panel. 
2. Click the System icon. 
3. In the System window, click on the Device Manager link 

located under the System heading. 
4. In Device Manager, scroll down to Ports. Expand the 

listings under Ports to reveal all the ports installed.  
5. Locate SILICON LABS CP210x USB to UART Bridge 

(COM x) (see Figure 28). 
6. Note the COM Port listed and select that COM Port in the 

A-910 Zigbee Utility software using the drop-down arrow. 
 
Setting the Target System ID and Target Network ID 
 
The System ID is a Radio Network Address that is used by the Radio 
Communications Protocol to filter unwanted data from other radio 
transceivers and targets using a different address. Only targets and 
radio transceivers that are set to a matching System ID can 
communicate with each other.  
Because no two targets with the same System ID can transmit 
simultaneously, it is necessary for each target to be programmed to 
respond only when it is being addressed. The Target Network ID is the 
target address on the communications network. Under Host 
(computer) control, the radio transceiver transmits a message called a 
polling request that contains the Target Network ID of one specific 
target. All targets receive all polling requests, but only the target with a 
Network ID matching the ID contained in the polling message will 
reply (Transmit Data to the Host).  
There are three rotary DIP switches located on the right side of the target, shown in Figure 29: 
• The uppermost switch sets the System ID. 
• The two lower switches are used to set the target network ID. 
 
Setting the System ID 
Note: Before selecting a System ID, ensure that it is not already in use by another system within the radio 
coverage area. 
Using a small screwdriver, rotate Switch 1 to align the arrowhead with the System ID number (0-9). 
Figure 29 shows the System ID switch set to 1. 
 

Figure 28 -- Device Manager showing COM Port for 
A-910 Dongle 
 

Figure 29 – Unitarget ID Switch set to1 
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Setting the Target Network ID and System ID for the R-1307 Readout 
 
To make the unit visible to all other radio-
enabled devices, you must set the Target 
Network ID and the System ID for the readout.  
1. Set the Local Readout/Target Network 

ID 
Press the MENU button until the upper 
display shows  (nn is also equal to 
the R-1307 number) and the matching 
target number with the current target ID  
() blinking. Use the UP and DOWN 
arrow keys to set the Target ID.   
 
Press the MENU button again until the 
lower display shows , with the 
current target ID () blinking. Use the UP 
and DOWN arrow keys to set the Target 
ID to the same value as that of the upper 
display’s Target ID.   

2. Set the System ID (Radio Channel) 
Press the MENU button until the upper 
display shows   , with the current 
System ID () blinking. Use the UP and 
DOWN arrow keys to set the System ID. 
Note that nn must be set to the same 
number as the channel switch setting of the 
A-910 radio transceiver (see Figure 30).  
 

Miscellaneous Display Messages 
 

 
  Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
    3 dashes.  Target detected but the laser is not on target. Check laser. 
 
  Radio channel cannot be selected because no Radio is present or detected.  

Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  

 
 Indicates a problem with the connection to the Cabled (Local) Target’s Position Sensing 

Device (PSD). Check plugs and cable(s).             
   
  Target ‘’ descriptor does not contain target calibration data. 

Figure 30– R-1307 with Cabled (Local) Target and A-910 Radio 
Transceiver 
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Appendix F – Converting X-Y Coordinates to Polar 
Coordinates in Alignment Reports 
 

 
Figure 31 – Corner position coordinates 
 
Figure 31 illustrates the corner position coordinates, as if the laser 
beam was located at the four respective corners. Also shown is an 
example of a laser beam located in the upper right quadrant of the 
PSD. The beam rotation angle is displayed in standard polar 
coordinates, as shown in Figure 32 (zero degrees at three o’clock 
and counter-clockwise rotation).  
Note that Y = Vertical Position and X = Horizontal Position. 
Hamar lasers position readings are not in Cartesian coordinates 
(i.e. above center positive, below center negative, right of center 
positive, left of center negative). For that reason, the signs of both 
the X and Y position values used in the ATAN2 function must be 
inverted.   

Ɵ (the beam rotation angle) is calculated as follows:  
1Ɵ (radian) = ATAN2 (-1*X, -1*Y) or 
Ɵ (radian) = ATAN2 (-1*(-.3), -1* (-.2)) = 0.588 
2Ɵ (degrees) = DEGREES (.588) = 36.690.  
Finally, convert the angle to all positive values: If Ɵ (degrees) < 0, add 360 
R (radius) = SQRT(X2 + Y2) = 3.6056 

 
1 In Excel: In MS Visual Studio, use Ɵ (radian) =  Math.ATAN2 (-1*Y, -1*X) 
2 In Excel: To manually convert radians to degrees, multiply radians by 57.29577951308232 (180/ Π). 

Figure 32 – Normal Polar Chart Orientation 
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Appendix G – Entering Data Manually in Bore9 
 
If it is necessary to enter data manually in the Bore9 software, follow the procedure below. 
 
1. Open Bore9 and create a new project file as described 

in Creating a New Project File or Opening an 
Existing Project File on Page 16.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Select the target to be used, the number of bores, and the spacing between the bores. If you are 

measuring bore diameters, enter the 
vertical and horizontal bore diameter of 
the reference bore and select the 
reference bore number. Enter the 
tolerances for Overall Straightness 
Tolerance and Bore- to-Bore Tolerance. 
Click 4 at the bottom of the screen. 
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3. If there is no equipment connected, 
the Comm Port Will Not Open 
message displays. Click OK. 

 
 
 
 
 
 
 
 
 
4. Click the Save button and close Bore9.  
 
 
 
 
 
 
 
 
 
  
5. Click the Windows Explorer icon and select Documents. 
 
 
 
 
 
 
 
 
 
 
 
6. Locate the BoreAlignmentApplication folder and open it. 
 

 
 
7. Open the Projects folder and then open the new project created in Step 1 on Page 63. 
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8. Open the ___RecordData.csv file. 
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9. An Excel spreadsheet opens.  
 

 
 
10. Enter the Normal Vertical readings for each bore in the Normal VC row and the Normal Horizontal 

readings for each bore in the Normal HC row. If inverted readings were taken, enter them in the 
Inverted VC and Inverted HC rows.  

 

  
 
11. Click File and Save. You will receive a warning that the data may contain features that are not 

compatible with CSV (comma delimited. Click Yes to keep the current format.  
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12. Click the red X in the top right corner of the screen to close Excel. When asked if you want to save 
the changes you made to the file, click No. 

 

 

 
 
 
 
13. Open Bore9 and click on the name of the project file you 

created in Step 1. Click 4 at the bottom of the screen. 
 
 

 
 
 
14. If the Comm Port Will Not Open message displays, click 

OK.  
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15. Click Recalculate at the bottom of the grid. Click Save. 
 

 
 
16. When the Overwrite Data? message displays, click Yes. 
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All of the manually-entered data has now been recalculated by the program. When you go to  
Step 5 – Results, this data is plotted on the Plot Screen. 
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Appendix H – Laser Buckin for Gearbox AOR (Manual 
Method) 
 
Laser Buckin AOR Procedure 
 
Insert L-705/706/708 laser into spindle fixture 
and set the micrometers to the Nominal 
Settings.  Turn on the laser to either Pulsed 
Mode (standard) or Continuous Mode 
(legacy). 
1. Rotate the laser to the INverted position 

(Vertical Arrow pointed at 6:00) until the 
bubble is centered in the level vial window. 
Note:  There is a bubble vial on both the 
top (NORMal) and bottom (INverted) of the 
laser. 

2. Insert the target and bore adapter into the 
far bore location. 

3. Ensure the laser is hitting the target.  If not, 
then use Rough Laser Buckin Using the 
Visual Method described on Page 34 to 
visually buck in the laser. 

4. Connect the R-1307 Readout (or R-358) and turn it on, making sure to match the laser mode (Pulsed 
or Continuous) in Step 1.  See Page 4 for more details on changing the laser mode in the R-1307. 
Insert A-910-2.4ZB Radio Receiver into the USB port on the computer. 

5. Open Bore9 and follow the steps in this manual (see Page 4) to configure the target to the readout so 
that the displays are showing live data.  

6. Write down the V and H values for the INverted Position.  
7. Rotate the spindle (holding the laser) 180 degrees to the NORMal position until the bubble is centered 

in the level vial window.  Write down the V and H values. 
8. Find the sum of the readings and divide by 2 (the number of readings) to calculate the laser Set 

Points.  
(Normal reading + Inverted reading)  

2 
  

Calculations for vertical and horizontal readings must be done separately. The formulas for 
vertical and horizontal set points are:  

(Normal V + Inverted V)    =    V SET POINT 
         2  

(Normal H + Inverted H)    =    H SET POINT 
                  2  

Example of calculating the Vertical Set Point. 
.  

VN = -.016 
VI = +.008 
  -.008 
Divide by 2 

 V Set Point =  -.004 

VN = -.016 
VI = -.008 
  -.024 
Divide by 2 

 V Set Point =  -.012 
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9. Turn the V and H micrometers (adjustment knobs on the L-708) until the V display value equals 
the V Set Point and the H display value equals the H Set Point. 

10. Rotate the laser to the INverted position.   
11. The V and H values should be the same as when the laser is in the NORMal position.  If not, then 

repeat Steps 7 thru 11 until the values are the same within your desired tolerance.   
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Appendix I – Laser Buckin for Gearbox AOR (Rough 
Buckin Visual Method) 
 
Rough Laser Buckin Using the Visual Method 
 
Note:  This procedure is performed without the target inserted in the barrel. 
 
1. Cover the far end of the barrel with white paper.  

Using a compass, draw a circle the same size as the bore diameter on a piece of white paper.  Mark 
the center of the circle.  Tape the paper to the far end of the barrel. The laser beam must be visible 
through the paper.  
Note:  Another way to make a circle in the paper is to lightly press the paper at the edge of the barrel 
and trace your fingers around the inside edge of the bore.  This will create a round crease showing 
the ID of the barrel.  Take a ruler to find the approximate center of the barrel and mark it with a 
pen/pencil. 

2. Mark the laser beam location on the paper.  
Set the laser to Continuous Mode (see Page 4).  With the laser placed in the NORMal (upright) 
position, draw a small circle where the laser beam hits the paper.     

3. Invert the laser, spindle adapter and the spindle AS A UNIT and mark the laser beam location 
on the paper. 
Using the bubble levels as a reference, rotate the spindle, laser, and adapter as one unit a total of 180 
degrees until the level bubble on bottom of the laser is on top and centered. Now draw a small circle 
where the laser beam hits the paper. 
Note: The laser, adapter, and spindle must be rotated AS ONE UNIT. Do not rotate the laser by 
itself. Also make sure that the circular level bubble is centered, or the results will not be accurate. 

4. Measure to find the Visual Set Point and adjust the laser beam.   
Using a ruler, measure the distance between the centers of both circles and mark the halfway point 
(see Figure 33) on the paper. This is the Visual Set Point. Turn the vertical and horizontal 
micrometers until the laser beam is centered on the Visual Set Point mark.   

 
Figure 33 – Visual Set Point 
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5. Invert (rotate) the laser, spindle adapter and spindle AS A UNIT to ensure that the laser beam 
remains at the Visual Set Point.    
Following the instructions in Step 3, invert (rotate) the laser, spindle adapter and spindle AS A UNIT 
to ensure that the laser beam is still centered on the set point mark. If not, repeat Steps 2 thru 5 until 
the laser stays centered on the Visual Set Point. 

6. Measure the distance from the Visual Set Point to the mark at the center of the bore.   
If the distance from the set point to the mark at the center of the circle is 0.4 in. (10 mm) or greater, 
move/align the end of the barrel until the center mark lines up with the Visual Set Point mark (see 
Figure 33).  This is called a rough alignment. 

7. Complete the setup procedures.  
Remove the paper and insert the target in the barrel, as described on Page 32, then follow the Laser 
Buckin procedure. 
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